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1. Activation 

Activation using Windows 

Upon starting EMOTION projects professional for the first time, 

you will be prompted to activate the program. Proceed as follows:  

Install EMOTION projects professional as described by the in-

stallation instructions.    

Input your serial number. For the box version, this can be found on 

the accompanying booklet. If you have chosen to download the 

program, you will find the serial number in your customer account 

at www.franzis.de. 

 

Klicken Sie in der Software anschließend auf den Button „Weiter“. 

Die Software wurde nun erfolgreich aktiviert! 

 

Activation using Mac 

Upon starting EMOTION projects professional for the first time, 

you will be prompted to activate the program. Proceed as follows:  

Install EMOTION projects professional as described by the instal-

lation instructions.    

http://www.franzis.de/
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Input your serial number. For the box version, this can be found on 

the accompanying booklet. If you have chosen to download the 

program, you will find the serial number in your customer account at 

www.franzis.de. 

 

Finally, click on the “Activate” button. The software has now been 

successfully activated!  

 

Note: EMOTION projects professional can be installed on up 

to two computers using the same serial number.   

A second serial number is not required. When installing the pro-

gram on a second device, simply enter the serial number again 

and press “Activate”.   

  

http://www.franzis.de/
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2. Configuring the user interface 

Optional font size for menus and titles 

In the main menu of the program you will find in View  Font size 

an option to customise the size of the letters in the menu as well as 

in the titles of the programm. 

 

The font size can be adjusted to the run time of the program.  

4K – monitors gives you the option to enlarge the font size for 

better readability of the menu. 

 

Select a font 

EMOTION projects professional offers you the opportunity to 

designate a suitable font of your preference. You will find a selection 

of the installed and compatible fonts in View Font, simply pick 

your favourite. 
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If you want to change the font back to standard select View  Font 

 reset font. 

 

 

 

 



EMOTION projects professional – User manual 

 

8 

3. Photos Done Quickly 

With EMOTION projects professional it takes just five clicks to 

reach the finished image: 

1. Load images  

2. Post-Processing  Select Preset  

3. Set Image Mood Assistant 

4. Set Optimisation Assistant 

5. Select Image Segment and Save, that´s it! 

 

You can simply drag and drop your images or bracketing series onto 

the start screen. 

This way you can reach your goal quickly - but you can also go the 

creative way with individual image adjustments or selective drawing: 

EMOTION projects professional offers both variants. 
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At the top of the screen are the main menu as well as the menu bar. 

This menu bar contains the following functions (from left to right): 

 

o Image data browser     

 

o History viewer      

 

o Load image      

 

o Open project      

 

o Batch processing      

 

Optionally, image data may can also simply be „dropped“ onto the 

screen by Drag & Drop. The image data is then uploaded automati-

cally. 

 

 

 

Image data browser 

For a better overview of your images you can use the image data 

browser before loading. Click on the corresponding icon in the 

menu bar. The preview window will open. Select your image folder 

at "Source folder". EMOTION projects professional will immedi-

ately start the calculation and display a preview image. Move the 

mouse over the preview image to enlarge it. 
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The file type-filter is practical here, since one often has jpg rows and 

RAW images together in one folder. But if you type in RAW in the 

file type, only the RAW rows will be shown. You won´t have any 

doubles any more.  
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At 100% the search for images is finished. 

From this point on you will be able to upload the desired bracketing 

series. Click on the desired row with a right mouse click and chose 

in the context menu “open as project”. 

 

 

 

EMOTION projects professional uploads the images of the de-

sired row and just like the simple Drag &Drop of the images on the 

desktop we start now with Post-Processing. 
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4. Module Explanation: Image Mood 

Assistant 

The Image Mood Assistant lets you test 

and apply a variety of different moods 

and image styles to your photo. These 

help lend your image an entirely new and 

unique look.  

Choose from up to 33 unique preconfig-

ured mood settings such as „Landscape: 

Sunlight“, „Dramatic/ Dull“, „Portrait: 

Golden Shimmer“, and many more.  

Click on the Image Mood Browser and 

you will see all 33 presets at a glance. 

Easily compare them to find the best fit 

to your photo. 

 

 

Use this button below to reset the 

changes made within the Image Mood 

Assistant: 
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Here’s an example from landscape photography: 

 

 

If you select a new image mood („Dramatic / Dull“), you give your 

photo an entirely new look: 
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There are five controls for the mood 

selection. Image moods are used to 

display emotions in the picture. You can 

select them either with the slide control 

in the middle of the scale or step by step 

with the lateral arrows.  

 

Three controls are available for 

selecting styles. You can choose 

between "cool - warm", "dull - 

glamour" and "vintage - modern”.  

 

In addition, there are four controls 

for Smart Filters in the Image 

Mood Assistant. These only 

improve certain areas within your 

image. For example, the settings 

of the Smart Sky slider only 

change the sky in your photo. 

"Smart Organics" changes the 

organic or plant elements in the 

picture. "Smart Skin" improves 

the skin tones and is therefore especially suitable for portraits. With 

"Smart Contrast" you can compress your picture or increase its 

brilliance.  
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Comparison: 

 

Smart Sky soft        Smart Sky intense 

 

Below the Image Styles you 

will find the button "Random 

mood" alongside the so-

called "Image Mood Index.” 

By clicking on the “Random Mood” button, you can generate an 

image mood index from 1 to 1,000,000,000 which combines image 

mood and image style at random. This yields a total of one billion 

different combinations. Each combination has its own image mood 

index. You can also enter it manually into the field or adjust it with 

the plus and minus buttons.  

Note: The Smart Filters are not used for generating random moods. 
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 With the UnDo button,  you can revert all values within the 

Image Mood Assistant back to the previous setting. There are 100 

UnDo levels in total. 

With the ReDo button, you can return to the setting present prior to 

clicking undo. 

You can increase or decrease the intensity of the entire image 

mood, (including the Smart Filters) using the buttons depicted be-

low:  and  

Reduce and increase specific settings in proportion to each other, 

i.e. one slider can move to the left while another is moved further to 

the right, depending on the desired effect. This works until one 

slider has reached the stop. 

Example:  
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After clicking Increase four times: 

 

 

You can also import as well as export image moods using the fol-

lowing buttons:  
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5. Menu bar 

5.1 File 

File → Start  

When you are finished with the editing of an image or you want to close the 

current image, simply click on Start (or Ctrg + N) to close. 

 

File → Load Image   

To open an image click on upload image (or Ctrg + Shift + O) to find the 

edited images.  

 

File → Image Data Browser  

Select your picture folder at "Source folder". EMOTION projects profes-

sional will immediately start the calculation. You can now load the desired 

image from here. 



EMOTION projects professional – User manual 

 

19 

File → History Viewer  

Click here to receive an overview of your projects so that you can choose 

between them. If you want to open an image, just double click on it. 

 

File → Save Final Image  

When you are happy with the image and you want to save it, simply click on 

save final image (or Ctrg + S). 

 

File →  Open Final Image In External Program  

If you want to edit the current image in a different image editing program, you 

will not have to leave EMOTION projects  professional. Simply click on 

open final image in external program. 

 

File → Print Final Image  

Click here if you want to print the current image. The image will be automati-

cally centralised and the print medium scaled to size. 

 

File → Final Image Into Clipboard  

The current image will be copied into the clipboard. You can add the image 

to other programs as well. 

 

File → Projects  

If you have already started a project EMOTION projects professional and 

you want to continue to work on the project, open this file by clicking on 

projects… 
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File → Exit  

Click on exit (or Ctrg + F4) to close EMOTION projects professional. 

 

5.2 Edit 

 
 
Edit → RAW Processing  

If you want to edit a photo without any complications, click on RAW devel-

opment to change for example colours or to distort the image (see 14. RAW 

processing). 

 

Edit → Post-Processing  

Once you have loaded an image, you are in post-processing mode. 

 

5.3 View 

View → EXIF Information Window  

Shows you (if available) all EXIF information of an image file e.g. place, 

camera type, exposure time and time. 

 

View → Histogram  

The histogram shows you compactly the information of exposure distri-

bution in a photograph. That way you can quickly identify if a photo is over- 

or underexposed. 
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View → Full Screen View On/ Off  

If you feel like you are being distracted by the task bar, you can simply click 

on full screen view on/off to switch into full screen. 

 

View → Interface Style… (dark grey)  

You can change the colour scheme of EMOTION projects professional by 

clicking on Inteface-Style. The currently used colour scheme will be dis-

played in brackets. 

 

View → Font  

Choose your individual font from all compatible and loaded fonts. EMOTION 

projects professional now displays the entire interface in the font you have 

selected. 

 

View → Font Size  

You can change the size of the font between small, standard and large. 
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View → Frame Colour: Grey Card -> automatic  

When you click on frame colour: grey card → automatic, the program will 

take the average frame colour of your image and will use it as your frame. 

 

View → Restore Window Defaults  

Resets the current window back to its original size. 

 

5.4 Extras 

 

 

Extras → Batch Processing (Ctrl + B)  

The batch processing of EMOTION projects professional allows the 

automatic processing of multiple images. 

 

Extras → Preparing Image  

Here you can prepare your images before post-processing (see 6. Image 

preparation). 
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Extras → Benchmark  

If you would like to test how quickly your PC can remove noise from your 

images, Benchmark is the function to choose. The programs will render five 

different images in real-time and provides you with an evaluation on a five-

star scale.  

Here the text size can be scaled in 4 sizes. 

 

Extras → Settings (Ctrl + P)  

Here you will find the various configuration options adaptable to your unique 

preferences offered in EMOTION projects professional.  

 

Program: Program Location 

Here you can determine to which folder to save your projects, exposure 

bracketing/ photo series, final images and default settings. 
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Program: Language 

Here you can change the EMOTION projects professional  program 

language to either German, English or French 

 

Program: Accelerate GPU 

Here you can choose to either activate or deactivate graphic card computing 

speed acceleration. 

 

Program: Tooltips 

Hovering your cursor long enough over specific tools or menu options will 

prompt the display of a short text offering an explanation of the function or 

tool. This is called Tooltip. Tooltips can also be deactivated here if preferred. 

 

Program: Progress Bar 

During of effects in EMOTION projects professional  processing will be 

displayed with the help of a progress bar. Here you can decide when and 

whether to display the progress bar. 

 

Program: Projects 

When selecting the compression level, you are deciding how much storage 

space will be allocated for each one of your projects. At the same time, you 

are also deciding on how quickly the storage is performed. A lower level 

saves the projects faster, a higher level reduces the amount of storage 

space available on your hard disc. 

 

Program: Undo 

With the option “save undo steps in projects”, you can save all undo steps 

within the project file. The undo-steps will then be completely reproduced 
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when the file is opened. This creates a significantly larger project file. Set the 

maximum number of undo steps (1, 5, 10, 20 or 50). If you do not wish to 

set a maximum, select “unlimited”.  

The minimum free disk space specifies the amount of free space on your 

hard drive that will not be taken up by saving undo steps. This ensures the 

proper functioning of your operating software. By default, this is set to 10% 

of your hard disk capacity but can be increased or decreased accordingly. 

 

Program: Preview Mode 

In preview mode you can choose between the modes “optimal” and “quick”. 

With the “optimal” mode activated, the preview size is adapted to the size of 

the original image. It guarantees maximum preview quality. If the “quick” 

mode is activated, the preview size is reduced to half of that of the original 

image. This guarantees you the highest possible speed in preview mode. 

Moreover, you can set the size of your preview area in megapixels if you 

have not selected optimal or quick mode). Select a high value if you have a 

very fast computer. 

 

Export 

External Programs 

Here you can choose in which format EMOTION projects professional will 

export images to external programs. You can specify as well which pro-

grams should be used for external image editing. 

Navigate to the file in which the function is installed and select it. 
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Calculation 

 

Quality 

The Calculation quality is a measure of the size of the area of influence 

around a given pixel used when it is calculated in an algorithm.  

Superquadrics describe geometrical forms (in this case, areas) with specif-

ic curvatures. This geometrical form is transferred to the influential area of 

the algorithms. For each pixel only surrounding pixels that are within its 

superquadric are considered (shown as a white area). If you want to maxim-

ize calculation quality for your shots, push both slides as far right as they go. 

Remember that this will require far more processing power. 
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Luminance conversion 

Luminance conversion allows you to determine which colour is valued higher 

when converted to brightness (luminance). You can select the three usual 

standard options in default settings. Alternatively, you can set colour 

weighting directly by using the slider. For this control, the sun of all three 

colour rations must add up to 100%.  

The two colour circles displayed help you to get an idea of how the value you 

entered affects the various colours. The left-hand circle shows the original 

colours while the right-hand circle shows the brightness as converted using 

your values. 
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Save formats 

Jpg 

Jpg or Jpeg is the most common and popular format for most cameras and 

image editing programs. Here you can control the quality as well as optimally 

compress the image. Compressed images with high quality look better but 

do require more storage space. 

Tif 

Here you can choose between different compression methods for your Tif 

files. 

 

 

Png 

Png is popular for its graphics and digital visualisation. Here you can choose 

between a number of compression methods. 

 

Automatic 

Automatic: Post Processing 

Post-processing automatically sets the corn engine back to its original set-

tings with every newly started project. To use a fixed corn value in batch 

processing, set this in the program and then deactivate this option. 
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Automatic: Security Questions and Additional Information 

Here you can choose whether or not to display security questions or addi-

tional information. 

 

Automatic: Automatic Undo Points 

Creates an automatic Undo-Point before RAW development, sensor correc-

tion or selective drawing. This creates a definitive starting point after upload-

ing the image. 

 

Automatic: Image Preparation 

Displays the image preparation window when images are exported over a 

Plug-in. 
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Automatic: Image Saving 

Activate the option “always save in highest resolution” and the processed 

image will automatically be saved in full resolution, even if the preview mode 

is active. Activate the option “show crop window when saving” and the crop 

window will automatically be displayed before image saving. 

 

Automatic: Batch Processing/ Image Data Browser 

Here you can activate the automatic loading with the last used directory 

when opening the image data browser. You also activate the automatic 

inclusion of subdirectories in the image data browser and batch processing.  

You can also prevent files from being overwritten by automatically adding 

the original file extension (e.g. jpg, tif,...) for the file name created in batch 

processing. 

 

Extras → Reset  

This returns the current user interface to its original size. 

 

Extras → Create Restore Point (Shift + Z)  

If you would like to save your image in its current state and continue editing 

without initiating a file-save, simply select the option Create Restore Point 

or (Shift + Z). This allows you to return to the last saved state of your image 

at any time. 

 

Extras → Timeline (Ctrl + T)  

Click on the Timeline or (Ctrl + T) to display all saved Undo-Points. 
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5.5 Addons 

 

 

Add-ons → Import Add-on  

With the help of Add-ons, you can now not only import Presets into EMO-

TION projects professional but also integrate new Post Processing Mod-

ules that gives your Presets with an entirely new look. 

 

Add-ons → Remove Add-on  

This button lets you remove add-ons. 

 

Add-ons → Addon Information  

Here you are provided with a display of all information regarding currently 

active Add-ons 
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5.6 Information 

 

Information → EMOTION projects – Homepage  

Click here to navigate to the EMOTION projects professional. 

 

Information → Show Shortcuts …  

Here you will find all keyboard shortcuts available in EMOTION projects 

professional. 

 

Information → Supported RAW Formats …  

A list of all cameras whose RAW Files are able to be opened in EMOTION 

projects professional. 

 

Information →  Check For Updates   

This checks online whether newer versions of the software are available for 

download. 

 

Information → About EMOTION projects (Shit + F1)  

Information about the current version, 3rd-Party Software and Credits from 

EMOTION projects professional. 
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6. Image Preparation 

Here you can precisely configure the program’s settings. For the 

first steps, please use the standard settings. These default settings 

can be restored with the arrow at the bottom left. Nothing can be 

irretrievably adjusted. 
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a. Scaling: When bracketed series are uploaded, the images 

can be scaled from 25% up to 900% using any one of 6 dif-

ferent available Scaling Processes. 

 

b. Colour space con-

version: Advanced us-

ers can choose a col-

our space here - for all 

other users, it is rec-

ommended to not make 

any adjustments in or-

der to avoid incorrect 

colour rendering later. EMOTION projects  professional 

offers several new colour spaces (D65). The standard il-

luminant D65 is representative for a phase of natural day-

light with the colour temperature of 6500° Kelvin. 

 

c. White balance corrects colour casts that occur with shots 

taken in shooting environments such as warmly lit rooms. 

To start, leave this setting unchanged.    

 
d. With this regulator one can adjust the colour temperature 

when you´re already uploading. It is advised that you leave 

the setting on “default” and to regulate the colour tempera-

ture later in post-processing. 
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e. Optimisations: Normalising the color ensures that the 

shadows in the image are black and the highlights in the 

image are white. The RAW to Camera Display adjust-

ment converts the RAW image on loading to be as close 

as possible to the camera preview and file preview. Auto-

matic Brilliance Optimisation for RAW files to be loaded 

can be activated in the RAW Options section of the image 

preparation menu. It is often the case with camera RAW 

formats that the image data does not make use of all pos-

sible tonal values. The Automatic Brilliance Optimisation 

compensates for this for the loaded RAW images and ex-

pands the tonal values so that a well utilized histogram is 

created for each camera RAW image.  

 

In bracketing, this option is only useful when creating HDR 

images from a single RAW. If the automatic rotation of 

images is activated, the images are automatically rotated ac-

cording to the Exif orientation. 
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7. Post-Processing: Presets 

 

We start directly in post-processing 

after the images have been loaded. 

Here we control the tonal value com-

pression of the images and process 

the results with filters and effects. 

Left side of the post-processing 

screen:  

At the beginning the preset "Neutral" 

is selected. By clicking on the thumb-

nails, the effects are calculated in real 

time and displayed in the center of 

the screen. 

Discover the wide variety of different 

looks by clicking on the 21 different 

presets. You will be amazed by the 

intriguing styles in the artistic section!   
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Image with „Dark“ preset 

 

 
Image with „Strong colour mix“ preset 
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All 21 EMOTION projects professional presets at a single glance. 

The bar “default settings” you can detach easily and adjust to the 

desired size. 

. 

 

 The variation browser 

 

The variation browser allows you to choose from different ver-

sions of a function and is primarily operated with the mouse: 

 Shifting the segment: hold down the left mouse but-

ton, before moving the mouse 

 Zooming in: scroll up 

 Zooming out: scroll down 

 Choosing the variant: double left click on the image 

 Setting a referent: left click on the image 

 Comparison with referent: hold down the right 

mouse button over the image 

 

The corresponding short cuts you can find under “information -

> short cuts”. 

 

Click on the symbol and EMOTION projects professional will 

show you the entire preview gallery of that chosen category. 

Zoom in now on the variant that you want to compare and set a 

reference image. 
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This reference image you will be able to put on any image 

through a left click of the mouse. You can fade in this refer-

ence image into the other image by holding down the right 

mouse button. The border surrounding the image in a green 

dashed line shows you the reference image so that you can 

make the comparison. In this way you can compare any two 

variants in the browser directly and visually. 

 

Example: As a reference image you choose the variant „Neutral“ 

and mark the image with a left mouse click. The green dashed line 

shows that you have chosen this image. 
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Now you look for a different preview image, in this case Preset “Very 

bright” has been chosen. 

 

 
 

 

Right click on the preset Very bright and the reference preset 

will fade in. As soon as you let go of the mouse button, you will 

see the Very bright preset again. This is how you simply and 

purposefully compare looks with another before choosing the 

ones you like the best.  

 

Selection of your desired variation: 

With a double click you chose the variant. The relevant pro-

gram settings will be carried out automatically. 

 

Tip:  

Your current choice will, when you open the window, be auto-

matically set as your reference image. 
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 Filter Presets 

Locating presets can be difficult when you have imported presets or 

created many additional looks. For example, enter “colour” into the 

search bar and only presets relating to “filter” will be shown, e.g. 

„Colourful“ or „Strong colour mix“. 

 
 

 Save Undo-Point  

With the Save Undo-Point Function you can save your edits to 

an image at different intervals and later view these in the Time-

line and pick up where you left off.  
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 Timeline  

In the Timeline you can view and directly access all saved Un-

do-Points. 

 

 Comparison View 

 

Do you want a comparison to the image 

without editing? Simply right click on the 

middle of the image to see the 

before/after result.  

A quick check on the editing process is 

available at any time. For an extensive 

overview with selectable areas and 

luminance display, click on the symbol 

bar. 

 

 Histogram  

The Histogram shows the distribu-

tion of tonal values within your im-

age.   

 

 

 High-Quality Display 

 

Activate this option to see the preview image in high-resolution. If 

the preview is set at 100%, there will be no difference. If you zoom 
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in on a section of the photo however, there is a noticeable differ-

ence in quality.  

 

 Border Pixel Display 

 

The border pixel display helps to reveal areas that tend towards 

maximal light and dark values that is to white and black. Dark border 

pixels are depicted by blue/ purple and light pixels by orange/ yel-

low. 

 
Depiction of border pixels in purple and orange tones.   

If you would want to brighten this image, you have to be careful of 

the orange border pixels. Light surfaces on the car and the walls 

should not become too white, in order to avoid losing detail. In tech-

nical terms, these patches are called “burned highlights”. The bor-

der pixel view helps to find these critical image areas 

 

 Symbol „original resolution setting“ 

 

With this pushbutton you will set the zoom factor on the original 

resolution. 
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  „Increase the Zoom factor to screen size“  

With this symbol you will enlarge the zoom factor to the maximum 

possible screen size. 
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8. Post-Processing: Finalise 

We have already understood an important part of the post-

processing, let’s move on into the fine-tuning (tools on the right side 

of the screen in the tab "Finalise"). All these operations are optional 

and only to be used if the images are to be further processed after 

selecting a preset.  

 

 The magnifying glass  

On the right-hand side (at the very top) in Post-processing you will 

find the 1:1 magnifying glass. The magnifying glass shows you the 

area under the mouse in a 1:1 pixel view. 

 

When clicking on the magnifying glass, the compare window will 

appear. This compares your edited image and the original image. It 

simultaneously gives you the opportunity to examine the compari-

son through the magnifier display. 
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To keep the magnifying glass on a specific point, press down on the 

“L“ key, while you move the mouse over the screen.  

          

 

Click into the image area of the magnifying glass, to change be-

tween the display modus “divided before/after comparison” and 

“direct before/after comparison”. To unlock the locked area, press 

the L button again. 
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 Optimisation assistant 

 

The optimisation assistant is a very efficient tool for fast, fascinating 

results. 

  

When the preset is activated, denoising, tonal value, clarity, 

dynamic and sharpness settings can all be adjusted by sliding the 

control to the left or right. The result can be seen live. 

The optimisation assistant is intelligent; it remembers the values you 

entered, and applies the same settings to the next image in the 

same way, but tuning the result to the new motif.  

If you would like to edit without the assistant, you can simply turn it 

off. If you would like to turn off the values that have been “learned” 

so far, click on the . 

Additionally, the assistant can be 

given optimising specifications for 

an entire image style: choose 

between „naturally cool”, „naturally 

warm”, „soft”, „fine” „brilliant”, 

„intense”, „muted colours”, „Multi-

colour”, „High-Key” , „Low-Key” 

und „Low-Key Multicolour”.  

 

 The opacity regulator of the optimisation assistant 

The opacity regulator in the optimisation assistant activates itself 

automatically as soon as one optimisation is activated. The opacity 



EMOTION projects professional – User manual 

 

48 

regulator works on every effect that optimises the image as well as 

the optimising presettings. 

 

 

Tip: 

Put the optimisation presetting in “High-Key” and chose an opacity 

regulator between 40-60%. 

 

Pro Tip:  

Remember that the preset specifications and Optimisation Assistant 

are added together. If you select the “Surreal powerful colours" 

preset and the “Intense” optimisation, you will get strong, saturated 

colours and dramatic contrast. Not to worry, you can quickly change 

back to the “Natural” optimisation and have the familiar look of the 

“Surreal powerful colours" again. On the other hand, you can com-

pile new creative ideas and jump between intense, unsaturated and 

high and low key looks lightning fast. 
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 Granulation module 

 

 

a) Natural grain 

In natural grain the different levels of photographic paper are simu-

lated, which creates a natural irregularity. 

These following parameters are therefore at your disposal: 

- Form  

Choose here from six different variants. 

 

 

- ISO-Number 

The preset value conforms to the average “restless value” 

on a naturally grey surface. 

 

- Size 

The maximum size of the simulated grain. 
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- Masking 

Gives you the opportunity to calculate the granulation in all 

different types of daylight or alternatively in light, shade or 

shade and light. 

 

Here the masking was set for the lights only - so the 

lights get a fine natural grain, while the blue sky areas 

are left out. 

A Click on the button creates a new random distribution of 

grain and therefore a whole new look. 

 

 

b) Fractal grain 

 

Fractal grain simulates a 

large-scale irregularity, which 

is created through the storing 

and deterioration of photo 

material. For this, you have 

the following parameters at your disposal: 
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- ISO-Number 

The preset value conforms to the average “restless value” 

of a naturally grey surface. 

 

- Quality 

Determines the accuracy of the calculation (number of iter-

ations for the fractal algorithm) of the fractal granulation. 

In the granulation module there is no singular best setting, 

since the ideal grain size, form and quality is 100% de-

pendant on the motif. Here you can try out different things 

and find new creative paths.  

  

 A Click on the button creates a new random distribution of 

grain and grants your image a whole new look. 
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9. Local Adjustments and Selective Drawing 

 

The selective highlight tool from EMOTION projects professional 

deserves very special attention. Firstly, this tool selectively edits 

chosen areas without complicated masks done by hand, like other 

photo editing programs. EMOTION projects professional includes 

a completely newly developed intelligent border recognition algo-

rithm that independently identifies 

borders, lines, differentiations and 

light differences in drawing mode. 

The boundaries of the area that the 

mouse skimmed over are saved as 

a mask. These easily and precisely 

set masks serve as the basis for 12 

important image enhancements: 

„Correct red eyes“, „Beauty“, „Shad-

ing“, „Illuminating“, „Intensifying colour“, „Reduce colour“, 

„Strengthen details“, „Reduce details“ und „Sharpen“ u. s. w..  

These masks can even be saved as its own image file and used in 

other photo editing programs.    

How it all works is probably easiest to explain with an example. 

Open the selective drawing window (post-processing, finalise - 

bottom right). A single RAW file, a bar in the water, serves as an 

image example. 

Now we want to make the bridge a little darker without changing the 

rest of the image - sky, water, etc. should not be darkened. 
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Quickly finalise your image with Selective Drawing 

 

1. Select editing objective 

 For this case, select “Shading”. Make sure that the select-

ed mask function is activated and the green checkmark is 

showing.  

 

 

2. Activate Drawing Mode    

3. Activate Filling Mode    
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4.  Run the mouse over the contours without clicking. You 

can decide and correct the brush size afterwards. 

 

 

5. Now look at the mask display. The object where the bor-

ders were automatically recognised is now depicted. Click 

and hold, and then trace your mouse along the edges of 

your chosen object until it is completely selected. In the 

blink of an eye we will see the effect as well as the overly-

ing mask.   

 

 

6. One fully selected, blend the mask out by moving the mask 

intensity control to the left. 
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7. You will now see only the effect that is brighter rocks - our 

objective was “Shading”. Now you can adjust the intensity 

of the effect by sliding the control towards the + or -, ac-

cording to your preferred strength. Done: the rocks are 

brighter while the sky, beach and water remain untouched 

by the editing.  

8. Click on “Close”. You will be returned to post-processing 

and the selective change will be applied. 

 

 

 

On the right side, one can clearly see the much darker bar after the selec-

tive correction. Sky and sea still have the same tonal values as before. 
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9. Use your quickly made mask for a further effect. Go back 

to the selective drawing. Our selective mask has remained.  

10. Click on  and copy the mask to the clipboard. Switch 

the mask to “Sharpen” and use the   to paste the mask 

back again. Now you have sharpened just the rocks, and 

the other parts of the image were not influenced. 

11. Every selectively applied effect can be activated and deac-

tivated with the green checkmarks.    

12. Borders have different intensities in every image. Presets 

normally do just fine, but sometimes it is necessary to ad-

just the contour and sharpness settings in order to reach 

perfect fine-tuned results. 

 

 

13. Have you drawn outside of the lines, despite the border 

recognition? You can easily remove it with the eraser .     

If you only want to remove a small section, use the eraser 

with limitation. When set to 50%, you can only remove 

50% of the mask, regardless of how much you erase. The 

limited drawing mode works in the same way, and only 

draws at a certain opacity. 

14. If you want to mask the entire image except for a small ob-

ject, it is a good idea to mask only the small object and 

then reverse the mask by clicking on the  



EMOTION projects professional – User manual 

 

57 

Pro Tip You have two filling modes to choose from when you want 

to fill a mask. When do you use which mask? We used the normal 

fill mode  as in our example for a large surface, which is also 

preferred for water and sky areas 

Ray filling mode   is very precise and favoured for smaller ob-

jects, geometric forms or subjects with straight lines, like in our 

example here. 

 

With ray filling mode you can mask just the walls of the skyscraper 

while the window surfaces are not selected.    

 

Functions and Possibilities in Selective Drawing 

- Optional mask colours 

Designate a colour for the presentation of the mask as well as the 

brush one of the ready-made colours.  
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The display will be immediately adjusted to your desired colour. 

 

- Selective Drawing – Creating Masks 

Masks can also be created from a colour or brightness. 

 

With the button (1) you activate the “Create Mask” modus. You will 

find yourself in the standard mode “Create Mask out of Colour”(2). If 

you want to create the mask from a brightness, chose the (3) 

button. 

The tolerance controller decides, how sharp (smaller value) or 

soft (higher value) the created mask will be. 

While you are in the “create mask” mode your mouse pointer will 

turn into a pipette. The colour or brightness in which your mouse 

pointer is set, will determine the type of mask being created. 
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In the above example we can see how a red mask has been created 

for the sky. 

Tip: If you want to combine several colours in one mask, simply 

click on the desired colours after each other with the pipette on the 

screen. The current colour will with every click be added to the 

current mask. 

 

- Selective Drawing – Smoothing Brush 

The smoothing brush (1) gives you the opportunity to draw se-

lective areas of the mask softly.  

 

To draw an area even softer, just go over the same area with the 

smoothing brush several times. 
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- Global Mask Functions 

In the area of global mask functions you will find several special 

modes that you can use directly.  
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1.  Reducing the entire mask outline 

becomes  

 

2.  Increasing the entire mask outline 

 becomes  

 

3.  Soft-focus effect on the entire mask 

 becomes  

 

With global functions there are two buttons – the left button fulfils the 

function with a lower effect while the one on the right with a bigger 

effect. 
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- Reset the Function of a Mask 

Every mask can be reset to its original state without effecting any 

other masks. Simply click on the waste paper button (1). 

 

After clicking on the button a security query will appear, so that no 

important work is lost by accident. 

 

-  Colour filter in selective drawing 

In addition to effect masks you will find 

the field of colour filter masks. Click on 

the dropdown menu to choose one of 

the following filters: red, orange, yel-

low, yellow-green, green, cyan, blue 

and violet.  

 

- Adaptation of automatic masks in the “Distortioncor-

rection” section of the RAW module 

Selective drawing works directly with the RAW module. This in-

cludes the “Distortion correction” that is part of the RAW module 

and that is applied completely automatically on several drawn 

masks. 
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In the example we have an image, in which the sky has already 

been masked. 

When we now continue by correcting the horizon within the image in 

the RAW module, the drawn mask will automatically adjust itself to 

the “Distortioncorrection”. 
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10. Composing Mode 

 

In the Composing mode of selec-

tive drawing you have the ability to 

build up to 4 layers of images into 

your current motif. 

To switch into the composing mo-

dus, click on the “composing” but-

ton (1). 

From the list of choices (2) you can 

choose with which composing level 

you want to work with. 

With the button (3) you activate the 

currently chosen mask. Now you 

can through a click on the frame of 

the image (4) upload any image 

you wish to create the next level. 

You can use RAW images, Jpg, Tiff 

as well as several other image 

formats. 

Underneath the display screen you 

will find the parameter area that 

begins with two buttons with the 

following functions: 

 

(5) Multiple application 

Reduce the size of the image on a 
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different level than the one that you´re currently working on. With 

this option you will be able to stretch the reduced image outwards 

(up, down, left, right). 

(6) Determine the width-to-height ratio 

This function allows you to determine the width-to-height ratio of the 

uploaded levels, since the width-to-height ratio in an uploaded im-

age level can differentiate from the current image you´re working on. 

This preserves the proportion of the levels. 

 (7) Horizontal Reflection 

This function allows the image layer to be mirrored horizontally. This 

enables more precise adjustment to the current image without hav-

ing to make changes to the image layer.  

(8) Vertical Reflection 

This function allows the image layer to be mirrored vertically. This 

enables more precise adjustment to the current image without hav-

ing to make changes to the image layer.  

 (9) The Control-parameter 

Width-to-height ratio: If the width-to-height ratio isn´t fixed with the 

button (6), you will be able to change the width-to-height ratio how-

ever you desire. 

Zoom: Choose the size of that image level by zooming in or out 

Shifting horizontally: Move the image level to the left or right 

Shifting vertically: Move the image of that level up or down. 

Exposure to light: Regularly the light from your current image does 

not match with the exposure of your other image levels. Here you 

can adapt the exposure and darken or brighten the images however 

you want, so that they match. 
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A night image with a not very fascinating night sky... 

 

....you can change within a minute with the help of composing 

into an eyecatcher. 
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11. Removal of Scratch and Sensor Errors 

 

 

Photography unfortunately shows every unwanted sensor imperfec-

tion that every photographer, despite internal camera sensor clean-

ing, knows and dreads. Don’t stress - just eliminate them! With the 

easy to apply correction function from EMOTION projects profes-

sional, it can even be fun.   

Pro Tip: This intelligent correction doesn’t only remove sensor 

spots, but other disturbing things too - a deserted beach has never 

been so easy to produce.   

Simply mark defects in your motif, the program will automatically 

substitute these areas with other appropriate parts of the image.   

 

The sensor spots are circled in red 
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Here’s how to go about correcting: 

Select the brush tool under (6) and click on the point of the image 

that you would like to correct. A circle will appear beside it that will 

serve as a source.  

Move this circle to a place on the 

image that can act as a source for 

the first marking. The selected area 

will then be improved based on the 

source.  

 

Prior to this, you can reveal sensor 

spots, which will appear as a bright 

patch in the image, with (1).  

 

(2) Allows you to expose or hide 

the fixed areas. The corrections are 

still active, even if they have been blended in.  Hiding is solely to 

enable a before and after comparison.  

You can select multiple areas to correct by simply clicking on the 

brush symbol (6) and adding another point.   

 

The button marked (3) can blend the targeted corrections in and 

out, which also controls clarity.  

 

NEW: Under the quality (10) tab, a dropdown menu including five 

new quality modes allowing you to automatically search for corre-

sponding areas will open. With the different quality levels you can 

scale how the automatic search proceeds. 

Note: This search quality is used for all of the following search area 

settings. 
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(5) Deletes the added corrections.   

 

The section marked (7) controls the size of the area that is to be 

corrected.   

 

You also have the option to automatically search for the best source 

area for the improvement. Click on the (8) button.   

 

Button (4) calculates the appropriate correction spots for all of the 

points automatically set using (8).   

All currently selected corrections can be deleted with the (9) button. 

  

The sensor spot corrector marks all of the patches and determines a 

source within the image that can be used as a substitute.  
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Successful sensor spot correction. 
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12. Workflow 

 Edit final image further in an external program 

EMOTION projects professional offers interaction with exter-

nal programs. This way you can take a successful HDR result 

to another photo editing program and continue there.   

 

 Open in other projects programs 

Click on the “Projects” symbol in the toolbar to open the image in a 

different program from the projects series. Use the drop-down menu 

beside the symbol to choose one of the programs that you already 

have installed on your computer. 

 

 

 Open in other photo-editing programs 

To directly open the image in another photo editing program, such 

as Adobe Photoshop, click on the corresponding button in the sym-

bol bar.   

If necessary, go through the 

settings to show the path to the 

program. Click on “Extras” in 

the menu and select “Settings” 

in the drop-down menu:  
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Next, click on the “Export” tab. You can enter the name of a photo 

editing program here, and save it for later as well.    

With the exception of Adobe, you have the option to rename the 

external editors. The name you assign will be displayed in the Quick 

Export menu in the toolbar of the main screen. 
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 Work with a Timeline and Restore Points 

This option can be found in the symbol bar at the top edge of the 

screen: 

 

“Create Restore Point” saves a virtual snapshot of the current set-

tings. You can now always return to this stage of your editing. You 

can save as many editing restore points as you like. The timeline 

displays the restore points and makes it possible to call up any 

phase of the editing process with just a single click:   

 

 

 

This function is especially useful when, for example, you are satis-

fied with an image, yet want to continue trying out different settings 

and effects. Simply set a restore point and carry on editing your 

picture. If you want to go back, simply click on your restore point in 

the timeline.    

If you click on  you can add your own note as a heading. 
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13. Selecting and Saving Sections of Images   

To save a final image, click on the button in the toolbar, go 

through the file menu or use the corresponding keyboard 

shortcut (Ctrl + S).   

 

 Cropping and captions 

 As soon as you have initiated a file save, the cropping and caption 

window will open. If you would not like to crop or add a caption to 

your image, click continue.  

 

At the top are several practical aids for perfect image composition 

and cropping. 

 You can set the aspect ratio and activate guidelines like the rule of 

thirds, the golden section or the golden spiral.  The new photo cen-

tre display is also quite practical which you can access by simply 

clicking on this button.  
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The centre of the window shows your final image. Fix the area to be 

saved by adjusting the corners and borders of the photo.   

At the bottom is an option to enter a caption. You can determine the 

size, position and background for the text. 

The size of the text will be automatically coordinated to the final 

cropping. 

 You can either crop by hand or 

use one of the 71 provided 

formats.    

 

Please note: If you choose 

the cropping ration, 13 x 18, 

for example the final image 

will not be saved as 13 x 18 

cm, rather as a ratio of 13 to 

18.    

 

You will also find the "Scale and Save" button at the bottom. With 

this option you can choose between 30 different templates for vari-

ous online platforms such as Facebook, Instagram, YouTube, etc. 

or simply specify your own scaling values (scaling in percent and 

resolution in pixels). 
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As soon as the image has been cropped and captioned, confirm the 

save and the following window will prompt you to select a file format 

and name your file. 
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14. RAW Processing 

You can upload and edit RAW 

image data with the integrated 

RAW mode. Numerous tools 

are available to you here, 

such as denoising/sharpen, 

exposure, colour and detail as 

well as powerful distortion 

capabilities. In this RAW 

mode changes that are made 

will be transferred onto the 

entire bracketing series, so 

that you only have to put in the 

settings once. 

 

Resetting the category: 

Every category can through a click on the reset-button (bottom left) 

be reset to its original state without influencing the settings of the 

other categories. 
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Überblick über die wichtigsten Funktionen im RAW-Modul: 

White balance: Here you can regulate the colour temperature. Use 

the pipette to select a white balancing colour directly from the im-

age.    

Denoising/ Sharpness: This feature regulates the image’s noise 

and sharpness. Control the quality and different types of noise such 

as colour noise, banding or hot pixels.   

Colour balance/ white balance: Here it’s all about colour and 

black/white correction. Modify the general colour mood and neutral-

ise white and black - the icing on the cake for professional colour 

correction. 

Exposure: Influence lights, shadows, contrast and brightness in the 

final image. With the new dynamic brightness you can adapt the 

light to the contents of each image individually. 

Details: Fine-tune clarity and micro-details with lights, shadows and 

midtones. 
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Colour: These colour settings are 

about luminosity in shadows and 

lights. Here you can also counteract 

unloved chromatic aberrations.  

The differentiated chromatic aberra-

tion by colour is used to remove 

chromatic aberrations of a certain 

colour. A lens curvature is calculat-

ed backwards on the selected col-

our channel. You have the choice 

between: "Light Diffraction Green", 

"Light Diffraction Blue" and "Light 

Diffraction Red".  

Palate: Adjust the saturation of 

individual colours.   

Distortion: Take a closer look. 

These mighty tools can straighten 

out the horizon, correct camera 

angles and lens errors. Use “Autofit” 

to automatically trim any awkward 

borders.  

 

The reference grid can be adapted in the distance between the 

grids as well as in its transparency. This is how you will always have 

the maximum overview when you are correcting your settings. 
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Lens correction: Corrects the edge light loss that occurs with 

some lenses. 

Peripheral light: Corrects the curvature of the lens. 

Horizon: Corrects the horizon by rotating the image. 

Vertical: Tilt the image left or right for vertical perspective correc-

tion. 

Horizontal: Tilt the image left or right for horizontal perspective 

correction. 

Zoom: Zooming the image avoids empty areas that may occur 

during distortion correction. 

Trapezoid left/ right: The vertical trapezoid correction pulls the 

image either at the left or right edge of the image and corrects the 

perspective. 

Trapezoid top/ bottom: Horizontal trapezoid equalization draws 

the image either at the top or bottom of the image and corrects the 

perspective. 

Stretch left/right: With this parameter you can stretch the image 

into the width, starting from the left or right edge of the image. 

Stretch top/ bottom: With this parameter you can stretch the im-

age upwards, starting from the top or bottom edge. 
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Aspect: Change the aspect ratio of your image files. 

Shift L-R: Shift the image files to the left or right. 

Shift U-D: Shift the image data up or down. 

 

Category FX: 

 

This category contains special effects like a mist & fog correction, 

save highlights, sepia and film grains as well as different gradients. 

Pro Tip: 

When you take a landscape shot, shift the controller to “Gradient 

top” to a dark tone and create in that way a neutral thick (ND) – 

process filter. 
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General:  

Activate the “360° panorama mode” to optimise matching edges of 

images in a panorama series. Save your settings as a camera pro-

file to save time in the future. This can be reset at any time.    

If you have conducted the settings in RAW mode, click on “apply”. 

If you save your settings in the camera profile, you will save a lot of 

time for future photographs. The settings can be reversed at any 

time 

  

 

Zoom and Brightness 

At the top right are the sliders for zoom and brightness of the picture 

display.  

Note: With the brightness setting of the picture display, you do not 

change the brightness of your picture, but only the display, for ex-

ample to be able to recognize the effect of a picture noise in darker 

areas. 

 

Histogram 

The histogram is located below the sliders.  
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RGB: Here the RGB values of the pixel are displayed below the 

mouse pointer. 

HSL: Displays the HSL values of the pixel below the mouse pointer. 

Note: HSL stands for Hue (colour angle), Saturation (colour satura-

tion) and Lightness (brightness).. 
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15. Batch Processing 

EMOTION projects professional’s batch processing allows for 

automatic processing of multiple bracketing series. The function can 

be found in the drop-down menu for “Extras” in the menu bar.  

First, choose the source folder where the individual images are 

located. The “Include all subdirectories” checkbox not only search-

es through all of the selected folders, but also all subfolders and 

their further subfolders. 

Note: Remember that looking through folders with several subfold-

ers can require a lot of time. This is why selecting “C:\“ is not rec-

ommended. 

 

Source file: Here you define where the result images of the batch 

processing should be saved. To do this, simply select the corre-

sponding folder using the "Select destination folder (. . .)" button or 

enter the destination folder directly in the text field. 

Results: You can choose from five formats for saving the result 

images from the batch processing. With .jpg, .tif, and .png, two 8-bit 

formats (LDR) and three 16-bit formats (HDR) are available. JPG 

images are always saved in the highest possible quality and TIF 

files are uncompressed and lossless. 
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 Processing settings 

In the processing settings, select the default settings for image 

preparation, image mood, and post-processing. These apply to all 

images in batch processing. 

Image preparation: Die Bildvorbereitung öffnet den Dialog zur 

Einstellung der Bild-Ladeoptionen wie Farbraum, Weißabgleich, 

Bildausrichtung etc. 
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Image mood: Select a default mood from the list. 

Post-Processing: Select the post-processing default for batch 

processing. As soon as you change the preset and post-processing, 

all thumbnails in the bracketing area will be recalculated so that you 

will always see a real view of the result. 

Note: On a Macintosh computer, this dialog opens before the batch 

window due to the system. 

In the image view you will see all the images found. 

With the checkbox in front of the image name you can exclude the 

image from batch processing or activate it again. The images them-

selves can be opened directly in EMOITION projects professional 

via a context menu. A preview of the resulting image with the default 

settings is located on the right-hand side. 
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16. Plug-in Installation 

EMOTION projects professional can also be used as a plug-in 

for Adobe® Photoshop. Newer versions of Photoshop are auto-

matically detected by EMOTION projects professional during 

installation and the plug-ins are installed in the respective plug-in 

folder. Older versions of Photoshop might require manual installa-

tion.  

 

If you purchased your software as a download or if you have lost 

your CD, the plug-ins are also available for download at: 

www.projects-software.de/plugins 

 

24.1 Using Photoshop Plug-Ins in Windows 

The following window will appear when installing EMOTION pro-

jects professional 

 

http://www.projects-software.de/plugins
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Select the version of Photoshop where you would like to install the 

EMOTION projects professional plug-in. Click on “next” and fol-

low the instructions from the installation assistant. The plug-ins will 

then be automatically installed.   

Please note: When using older Windows systems, it can occur 

that not all Plug-ins are automatically installed. Should this occur, 

simply copy the preferred Plug-in directly into the appropriate 

folder of your current Photoshop version as shown in the picture 

below. Should you be using an older Photoshop version, simply 

copy the lowest Plug-in.  

Example: Photoshop CS6 users should copy the Plug-in for Pho-

toshop CS6 and not Photoshop CC 2014. In this case CC 2017. 

The corresponding Plug-in can be found on the CR-ROM under 

“Plugins”.   

The folder can be found under C:\Programme\Adobe\Adobe 

Photoshop CC 2017\Plug-ins  

 

You can also complete the Plug-ins installation at a later date. 

Please install Photoshop before attempting to install the 

Plug-ins! Following installation of the Plug-ins, please reopen 

Photoshop.  
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In Photoshop under the menu tab “Filters” you will the entry 

Franzis. All Plug-ins from the projects-collection can be found 

listed here.  

 

Click on EMOTION projects professional. The image opened 

and edited in Photoshop will now be opened in EMOTION pro-

jects professional.  

The program now finds itself in Photoshop Filter Plug-in Mode. 

You can edit the photo in EMOTION projects professional just 

as usual. Once you are done editing, you can send the finished 

version back to its original Photoshop Layer by clicking on “Ap-

ply”.  
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The “Cancel” button closes the Filter Plug-in without sending the 

changes made to the image back to the Photoshop Layer. 

Changes made in EMOTION projects professional are there-

fore discarded.  

 

The project program will then automatically close itself. This 

mechanism is conducted by Adobe Photoshop and cannot be 

stopped. 

 

24.2 Using Photoshop Plug-ins with MAC OS X 

Plug-ins can be found on the start screen in the “Plug-ins” folder. 

Select the appropriate folder for your version of Photoshop (we 

chose Photoshop CS6 for our example). Double click the .zip file 

to extract the plug-ins. 

Next, drag & drop the plug-in EMOTIONprojectsProfessional-

Filter_PH6.plugin (PH7 with other Photoshop versions) to the 

plug-in folder for your version of Photoshop, which is normally la-

belled as “plug-
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ins”:

 

Start up your version of Photoshop, load an image and navigate to 

„Menu Filter Franzis EMOTION projects 7 pro-

fessional“ 

One click will start the plug-in. With a click you start the Plug-In. 

The image will now be opened in EMOTION projects profes-

sional. 

 

Now you will find the program in Photoshop Filter-Plugin mode. 

You will be able to edit the image as you´re used to in EMOTION 

projects professional. 

 

When you´re finished editing the image you can send the image 

directly back to Photoshop by clicking on the button “apply”. 
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With the button “discard” you finish the filter Plug-in, without 

sending the changes that you have done to the image back to the 

Photoshop level. The editing that you have done in EMOTION 

projects professional will be discarded.  

The project program will then automatically close itself. This 

mechanism is conducted by Adobe Photoshop and cannot be 

stopped. 
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24.3 Using Adobe Lightroom Plug-ins - Windows 

 

Start the installation program and check in the component selec-

tion if “Lightroom Plugin” has been chosen 

 

If you have no CD, the plug-in is also available for download at: 

www.projects-software.de/plugins. 

 

Subsequently open your Lightroom version. Start Lightroom and 

navigate to „File Plug-in manager“ to check if the plug-in 

has been activated. 
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Should this not be the case, you have the additional possibility of 

manually installing the Lightroom Plug-in by clicking on “Add” op-

tion found in the Plug-in Manager.  
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To do this, navigate your way to the Plug-in folder containing Ap-

pData/Roaming/Adobe/Lightroom/Modules/EMOTIONProjectsPro

.lrplugin  
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As soon as you find yourself in the folder labeled EMOTIONPro-

jectsPro.lrplugin, click on the option “Choose Folder” to install the 

Lightroom Plug-in.   

Lightroom: EMOTION projects professional: Installed and exe-

cuted. 

 

Mark a bracketing series in your lightroom library.  

 

Right-click on the image directly in Lightroom and select „Export 

Export to EMOTION projects professional“. 
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Or: Choose „File Export with Preset Export to EMO-

TION projects professional“. 
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24.4 Using Adobe Lightroom Plug-ins - MAC OS X 

The Plug-In for Adobe Lightroom will not be automatically installed 

with MAC OS X. To integrate it into Lightroom, continue as fol-

lows:   

Install EMOTION projects professional to the program link of 

your Mac.  

Copy the plug-in .zip file from the “Lightroom Plug-in” folder on 

your CD-ROM. We recommend the folder where also your presets 

are stored:  
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„Users/username EMOTION projects professional “. 

Start Lightroom und navigate to „File Plug-In Manager“. 

 

Click the “Add” button in the Lightroom Plug-In Manager.   
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Choose the relevant Lightroom-Plug-In of EMOTION projects 

professional that you have just copied to your computer, by nav-

igating towards it. 

 

If the Plug-in is not instantly marked with a green active dot, close 

Lightroom and start it again. 
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Now the Plug-In should be installed and be up and running. 

You have now several options to get your image from Lightroom to 

EMOTION projects professional. 

„File Export with file Export to EMOTION projects 

professional“. 
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OR:  

 

Right-click on the image directly in Lightroom and select „Ex-

portExport to EMOTION projects professional “. 
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17. Keyboard Shortcuts 

Overview of the integrated Keyboard shortcuts 

In the main menu in the area of information you will find an over-

view of all available keyboard shortcuts.  

 

Click on this item to open the overview: 

 

In the overview you will be able to scroll through the different areas, 

where you can take shortcuts. 
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General: 

Windows Apple 

Ctrl N  cmd N New Project 

Ctrl Shift O  cmd Shift O  Upload Single Image 

Ctrl S  cmd S  Save Final Image 

Ctrl D  cmd D  Print Final Image 

Ctrl C cmd C Insert Final Image Into Clipboard  

Shift Z  Shift Z  Create Undo Point 

Ctrl T  cmd T  Open Timeline 

Ctrl F4 cmd F4 Exit Programme 

F4 F4 Open RAW Module 

F7 F7 Switch to Post Processing 

Ctrl P  cmd P  Open Setting 

Ctrl B  cmd B  Open Batch Processing 

@ @ Open Homepage 

Shift F1 Shift F1 Open About Dialogue 

Ctrl E  cmd E  Display Exif Information 

Ctrl H  cmd H Display/ Hide Histogram 

Ctrl F  cmd F Display Full Image 

 

 

Image Display Functions: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out 

Ctrl 0 cmd 0 Fit Image to Screen 

Ctrl 1 cmd 1 100% Display View 

L  L Configure Radar Window (lock) 
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RAW Development 

Windows Apple 

Ctrl + cmd + Zoom In 

Ctrl - cmd + Zoom Out 

 

History Browser: 

Windows Apple 

Image up  Image up Previous page 

Image down  Image down  Next page 

Home  Home To Start 

End End To End 

Cursor left  Cursor left Previous Entry 

Cursor right  Cursor right Next Entry 

 

Variation Browser 

Windows Apple 

Ctrl + cmd + Zoom In 

Ctrl - cmd - Zoom Out 

Cursor left Cursor left Move View to the Left 

Cursor right Cursor right Move View to the Right 

Cursor up Cursor up Move View Up 

Cursor down Cursor down Move View Down 

Ctrl 0 cmd 0 Display All 

Space Space Move View Around Centre 

S S Select Entry 

Del Del Delete Entry 

X X Compress View 

Home Home 1 Reset View 
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Sensitive Selective Painting: 

Windows  Apple 

Ctrl +  cmd - Zoom In 

Ctrl -  cmd -  Zoom Out 

Ctrl O cmd O 100% View/Switch Fitting 

A  A Activate Brush 

Shift A  Shift A  Activate Limited Brush 

S S Activate Erasing Brush 

Shift S  Shift S  Activate Limited Erasing Brush 

W W Activate Soft-Focus Brush 

E  E Activate Mask-Creation from the Image 

D  D Activate Filling Mode 

F  F Activate Filling Mode for the Brush 

R  R Activate Ray Mode for the Brush 

1 1 Reduce Brush Size 

2 2 Increase Brush Size 

3 3 Reduce Opacity 

4 4 Increase Opacity 

5 5 Softer Contour Recognition 

6 6 Sharper Contour Recognition 

7 7 Reduce Softness 

8 8 Increase Softness 

Ctrl Z  cmd Z Previous Step 

M, Shift M  M, Shift M  Mask Display On/Off 

 

Scratch & Sensor Error Correction: 

Windows Apple 

Ctrl + cmd + Zoom In 
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Ctrl - cmd - Zoom Out 

 

Cursor left, Shift Cursor left, Ctrl Move Active Correction Area to the  

Cursor left  Left 

Cursor right, Shift Cursor right, Ctrl Move Active Correction Area to the 

Cursor right  Right 

Cursor up, Shift Cursor up, Ctrl Move Active Correction Area Up     

Cursor up   

Cursor down, Shift Cursor down, Ctrl Move Active Correction Area Down   

Cursor down   

Image up  Image up Select Previous Correction Area 

Image down Image down Select Next Correction Area 

C  C Active All Correction Areas 

N  N Set New Correction Area 

Del  Del Delete Active Correction Area 

+ + Increase Active Correction Area 

- - Reduce Active Correction Area 

 

Picture Cropping: 

Cursor left, Shift Cursor left, Ctrl Move Cropping Area to Left 

Cursor left 

Cursor right, Shift Cursor right, Ctrl Move Cropping Area to Right 

Cursor right 

Cursor up, Shift Cursor up, Ctrl Move Cropping Area Upwards 

Cursor up 

Cursor down, Shift Cursor down, Ctrl Move Cropping Area Downwards 

Cursor down 
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18. Integrated List of supported RAW For-

mats 

In the main menu in the area information you will find an integrat-

ed list of supporting camera RAW-formats sorted by manufactur-

er.  

 

 

In the top area of the window you will find a selection of choices, 

with which you will be able to filter the list for singular camera manu-

facturers. This way you will find your camera faster. To have con-

stant access to the supporting camera RAW- formats via a separate 

window, you can use the function „open in browser“(window bottom 

left), which will show the list in a standard browser. You will also be 

able to print the supporting RAW-formats from there. 
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Copyright 

 

FRANZIS Verlag GmbH has compiled this product with special care. Please 

observe the following regulations: 

The individual programs, routines, controls, etc. contained on this data 

medium or in this download are protected by copyright by their manufactur-

er or distributor as indicated in the respective program. The purchaser of 

this software is entitled to use the programs, data or data groups, which are 

not marked as shareware or public domain, for his own purposes as in-

tended. Programs or program parts that are marked as shareware, free-

ware or public domain may be used by the purchaser in accordance with 

the information contained in the programs or program parts. Reproduction 

of programs for the purpose of distributing data carriers containing pro-

grams is not permitted. The copyright for the selection, arrangement and 

classification of the programs and data on this data carrier or in this down-

load is held by FRANZIS Verlag GmbH. 

The data and programs stored on this data medium or in this download 

have been carefully checked. However, in view of the large number of data 

and programs, FRANZIS does not guarantee the correctness of the data 

and the error-free running of the programs. The publishers and FRANZIS 

Verlag GmbH do not assume any guarantee or legal responsibility for the 

use of the individual files and information, for their economic efficiency or 

error-free functioning for a specific purpose. 

Also, no guarantee is given that all data, programs, icons, sounds or other 

files contained therein are freely usable. Accordingly, the publisher cannot 

be held liable for the infringement of patent and other rights of third parties. 

Most product designations of hardware and software as well as company 

names and company logos mentioned in this work are also registered 

trademarks and should be considered as such. The publisher essentially 

follows the manufacturer's spelling of the product designations. 
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